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２．転送命令を学ぼう 
2004年8月に本講義ノートをWebにアップして以来，とても多くの方の
訪問を受けてきました．内容が一部古くなっていたので，2012年5月時
点の情報に書き改めました．主な変更点は以下の通りです． 
 
第0章に本講座の準備のための章を設け，以下の更新をしました． 
 
１．プログラム開発環境(MPLAB IDE)をv8.84に更新しました． 
        2012年5月時点での最新バージョンはMPLAB X IDE v1.10ですが，

アセンブラの勉強のためには，旧バージョンのv8.84が良さそうで
す．（筆者がXを使いこなしていないこともあります．） 

２．ブレッドボード上に回路を製作し，その詳細を記しました． 
  ハンダ付けをほとんど必要とせずにマイコン回路を製作できます． 
３．部品を全てネットで購入して，その仕様と入手先を記しました． 
  入手が容易な部品ばかりでマイコン回路を製作しました． 
４．In-Circuit Debugger/ProgrammerにPICkit3を用いました． 
  ブレッドボード上のマイコンへのプログラミングにPICkit3を使用し

た例を記しました． 

http://xeon.cmplx.cse.nagoya-u.ac.jp/~furuhashi/education/PIC/
http://xeon.cmplx.cse.nagoya-u.ac.jp/~furuhashi/education/PIC/
http://www.mybook-pub-site.sakura.ne.jp/PIC/index.html
http://www.mybook-pub-site.sakura.ne.jp/PIC/index.html
http://www.mybook-pub-site.sakura.ne.jp/PIC/index.html
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; Load of Literal to Working Register 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &    _CP_OFF 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 
 MOVLW    B'10011010' ; Binary number 
 
 MOVLW  0xAB  ; Hexadecimal number 
 
 MOVLW  D'255'  ; Decimal number 
 
 GOTO  START 
  
 END 

まず，このソースファイルを打ち込んで下さい． 
MPLAB IDE v8.84の立ち上げ方，Project Fileの作り方，

アセンブラのソースファイルの作り方，ビルドの仕
方，シミュレーションの仕方は第0章を参照してくだ
さい． 注意 CONFIGの前のアンダーバーは2つあります． 

これはWレジスタにLiterarl（リテラル，文字）を転送さ
せるプログラムです．最初に2進数の10011010を転送し，
次に16進数のABを転送し，最後に10進数の255を転送し
ます． 
MOVLWはMove Literal to Working registerの略です． 

http://www.mybook-pub-site.sakura.ne.jp/PIC/index.html
http://www.mybook-pub-site.sakura.ne.jp/PIC/index.html
http://www.mybook-pub-site.sakura.ne.jp/PIC/index.html
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カーソルをこ
こに持ってき
て右クリック 

シミュレーションの仕方 
プログラムを打ち込み終わったら，Debugger → Select Tool → MPLAB SIM → Project → 
Makeと選択すると，プログラムに文法上の間違いがなければ，BUILD SUCCEEDEDとい
うメッセージが出ます．次にView → Special Function Registersを選択して下さい．下図の

ようにレジスタ群の内容を示すウィンドウが開かれます．図示の位置にカーソルを持って
きて右クリックすると，レジスタ内容の表示型をHex(16進数)，Binary(2進数)，Decimal(10
進数)，Char（文字型）の中から選択できます． 
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DecimalとBinary
を表示 

ファンクションキーのF7を押して，プログラムを一行ずつ実行して，  
WREG (Wレジスタ）の中の数字がどう書き換えられていくかを確認
してください． 

Wレジスタ

内の数字が
表示されて
います． 
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命令デコーダ 
コントローラ 

８レベルスタック 
ファイルレジスタ 

８ビット 

FSRレジスタ 

入出力ポート 

プログラムメモリ 
 

命令レジスタ 

MUX 

STATUSレジスタ 

Wレジスタ 

１４ 
1３ビット 

１３ 

７ 

６８ 

７ 間接 
アドレス 

RA４～RA０ RB７～RB０ 

制
御
信
号 

…
 

ＭＵＸ 
５ 直接アドレス 

８ 

ＡＬＵ 

８ 

８ 

デ
ー
タ
バ
ス 

プログラムカウンタ 

 

打ち込んだプログラムはプログラムメモ
リに格納されます．マイコンの電源を入
れると，プログラムメモリから命令が順
次読み出され，実行されていきます． 

PIC16F84AのData SheetのBLOCK DIAGRAMの抜粋です． 
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命令デコーダ 
コントローラ 

８レベルスタック 
ファイルレジスタ 

８ビット 

FSRレジスタ 

入出力ポート 

プログラムメモリ 
 

命令レジスタ 

MUX 

STATUSレジスタ 

Wレジスタ 

１４ 
1３ビット 

１３ 

７ 

６８ 

７ 間接 
アドレス 

RA４～RA０ RB７～RB０ 

制
御
信
号 

…
 

ＭＵＸ 
５ 直接アドレス 

８ 

ＡＬＵ 

８ 

８ 

デ
ー
タ
バ
ス 

プログラムカウンタ 

 

マイコンの中にはWレジスタ
(Working Register)という8ビットの

数字を記憶しておく場所がありま
す．様々な処理のための「作業用
レジスタ」という意味です． 

PIC16F84AのData SheetのBLOCK DIAGRAMの抜粋です． 
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命令デコーダ 
コントローラ 

８レベルスタック 
ファイルレジスタ 

８ビット 

FSRレジスタ 

入出力ポート 

プログラムメモリ 
 

命令レジスタ 

MUX 

STATUSレジスタ 

Wレジスタ 

１４ 
1３ビット 

１３ 

７ 

６８ 

７ 間接 
アドレス 

RA４～RA０ RB７～RB０ 

制
御
信
号 

…
 

ＭＵＸ 
５ 直接アドレス 

８ 

ＡＬＵ 

８ 

８ 

デ
ー
タ
バ
ス 

プログラムカウンタ 

 

MOVLW    B‘10011010’ の実行 

プログラムがスタートすると最初に
MOVLWがプログラムメモリから命令

デコーダに読み込まれ，ここで命令の
解読，コントローラにより実行されま
す．MOVLWの次の10011010がWレジ
スタに転送されます． 
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; Load of Literal to Working Register 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &    _CP_OFF 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 
 MOVLW    B'10011010' 
 
 MOVLW  0xAB 
 
 MOVLW  D'255' 
 
 GOTO  START 
  
 END 

Configuration設定です．マイコンのシス
テムクロックを設定します． 

MicrochipのWebページからダウンロードで
きるPIC16F84AのData Sheetの21ページに
Configurationの説明があります． 
OSC: Oscillator 
   RC: Resistor/Capacitor 
     内蔵の発振回路，4MHz程度まで 
          発信周波数は不安定 
   HS: High Speed Crystal/Resonator 
           3.5MHz 以上で推奨 

 本回路では10MHzのセラミック発振子を外付けして

あるので，HS設定とする． 
   XT: Crystal/Resonator 
        4 MHz 以下 
   LP: Low Power Crystal 
     低消費電力, 200kHz 以下 
 
WDT: Watch Dog Timer 
 
PWRTE: Power up Timer Enable 
 
CP: Code Protection 

本資料の使
い方の範囲
内では全て
オフで差し
支えない． 
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; Load of Literal to Working Register 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &    _CP_OFF 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 
 MOVLW    B'10011010' 
 
 MOVLW  0xAB 
 
 MOVLW  D'255' 
 
 GOTO  START 
  
 END 

現実のマイコンでは電源を入れる
とここから始まります． 

STARTへジャンプする． 
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; Load of Literal to Working Register 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &    _CP_OFF 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 
 MOVLW    B'10011010' 
 
 MOVLW  0xAB 
 
 MOVLW  D'255' 
 
 GOTO  START 
  
 END 

Wレジスタ 

10011010 

wレジスタに100110101という数
を転送せよという命令です． 

B’10011010’    2進数は 
= D‘154’    10進数 
= H‘9A’          16進数です． 
表現が違うだけでどれも同じ
数字です． 



; Load of Literal to Working Register 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &    _CP_OFF 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 
 MOVLW    B'10011010' 
 
 MOVLW  0xAB 
 
 MOVLW  D'255' 
 
 GOTO  START 
  
 END 

11 

Wレジスタ 

10101011 

wレジスタにABという数を転送
せよという命令です． 

B’10101011’    2進表現 
= D‘171’    10進表現 
= H‘AB’          16進表現 



; Load of Literal to Working Register 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &    _CP_OFF 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 
 MOVLW    B'10011010' 
 
 MOVLW  0xAB 
 
 MOVLW  D'255' 
 
 GOTO  START 
  
 END 
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Wレジスタ 

11111111 

wレジスタに255という数を転
送せよという命令です． 

B’11111111’    2進表現 
= D‘255’    10進表現 
= H‘FF’          16進表現 
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Wレジスタ 

11111111 

STARTへジャンプする． 

; Load of Literal to Working Register 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &    _CP_OFF 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 
 MOVLW    B'10011010' 
 
 MOVLW  0xAB 
 
 MOVLW  D'255' 
 
 GOTO  START 
  
 END 
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次に，ワーキング（W）レジスタと

ファイルレジスタ間でのデータの
やりとりを体験してください． 
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命令デコーダ 
コントローラ 

プログラムカウンタ 
(PC) 

８レベルスタック 
ファイルレジスタ 

８ビット 

FSRレジスタ 

入出力ポート 

プログラムメモリ 
（フラッシュメモリ） 

命令レジスタ 

MUX 

STATUSレジスタ 

Wレジスタ 

1４ビット 

１０２４ 

１４ 
1３ビット 

１３ 

７ 

６８ 

７ 間接 
アドレス 

RA４～RA０ RB７～RB０ 

制
御
信
号 

…
 

ＭＵＸ 
５ 直接アドレス 

８ 

ＡＬＵ 

８ 

８ 

デ
ー
タ
バ
ス 

  ＰＩＣ１６Ｆ８４Aの構成 

マイコンの中にはファイルレジス
タ(File Register)という8ビットの
数字を記憶できるレジスタが68個
あります． 
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0x0C 

0x4F 

0C～4Fの番地を持
つ68個の８ビット
レジスタがある． 
 
8ビットの数字を68
個までしまってお
ける「引き出し」
のようなもの． 
 
データの「一時保
管所」のような意
味です． 

   ファイルレジスタ     
 
 
 
 
 

   wレジスタ     Wレジスタはたっ

た１個の８ビット
レジスタからなる． 



17 

; Data from Working Register to File Register and vice versa 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF 
 
MEM1 EQU 0x0C  ;MEM1 at 0C 
MEM2 EQU 0x0C+1  ;MEM2 at 0D 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 MOVLW    0x9A  ; '9A' to Working Register 
  
 MOVWF MEM1  ; Move '9A'  to MEM1 
  
 MOVLW 0x01  ; '01' to Working Register 
 
 MOVWF MEM2  ; Move '01'  to MEM2 
 
 MOVF MEM1,0  ; Load '9A' from MEM1 to W 
 
 MOVF MEM2,0  ; Load '01' from MEM2 to W 
 
 
 GOTO START 
  
 END 

このプログラムを
打ち込んで下さい． 
 
 
シミュレータでプロ
グラムをステップ
実行しながら，w, 
MEM1, MEM2レ
ジスタの中の数字
がどう変わるか確
認して下さい． 
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MEM1, MEM2の中の数字は，View → File Registersにより見ることができます． 

0C番地にMEM1 
0D番地にMEM2 
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0C番地のファイルレジスタに
MEM1という名前を 
つけ，0C+1 ( = 0D)番地のファ
イルレジスタにMEM2という名
前を付けます． 

; Data from Working Register to File Register and vice versa 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF 
 
MEM1 EQU 0x0C  ;MEM1 at 0C 
MEM2 EQU 0x0C+1  ;MEM2 at 0D 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 MOVLW    0x9A  ; '9A' to Working Register 
  
 MOVWF MEM1  ; Move '9A'  to MEM1 
  
 MOVLW 0x01  ; '01' to Working Register 
 
 MOVWF MEM2  ; Move '01'  to MEM2 
 
 MOVF MEM1,0  ; Load '9A' from MEM1 to W 
 
 MOVF MEM2,0  ; Load '01' from MEM2 to W 
 
 
 GOTO START 
  
 END 
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電源を入れるとORG 0の次から始まります． 

STARTへジャンプする． 

; Data from Working Register to File Register and vice versa 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF 
 
MEM1 EQU 0x0C  ;MEM1 at 0C 
MEM2 EQU 0x0C+1  ;MEM2 at 0D 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 MOVLW    0x9A  ; '9A' to Working Register 
  
 MOVWF MEM1  ; Move '9A'  to MEM1 
  
 MOVLW 0x01  ; '01' to Working Register 
 
 MOVWF MEM2  ; Move '01'  to MEM2 
 
 MOVF MEM1,0  ; Load '9A' from MEM1 to W 
 
 MOVF MEM2,0  ; Load '01' from MEM2 to W 
 
 
 GOTO START 
  
 END 
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Wレジスタ 

10011010 

; Data from Working Register to File Register and vice versa 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF 
 
MEM1 EQU 0x0C  
MEM2 EQU 0x0C+1 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 MOVLW    0x9A   
  
 MOVWF MEM1   
  
 MOVLW 0x01   
 
 MOVWF MEM2   
 
 MOVF MEM1,0   
 
 MOVF MEM2,0   
 
 
 GOTO START 
  
 END 

wレジスタに
100110101という数を
転送せよという命令 



; Data from Working Register to File Register and vice versa 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF 
 
MEM1 EQU 0x0C  
MEM2 EQU 0x0C+1 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 MOVLW    0x9A   
  
 MOVWF MEM1   
  
 MOVLW 0x01   
 
 MOVWF MEM2   
 
 MOVF MEM1,0   
 
 MOVF MEM2,0   
 
 
 GOTO START 
  
 END 22 

Wレジスタ 
wレジスタの内容

をファイルレジスタ
のMEM1に転送

せよという命令で
す． 
MOVE W to F の
略です． 

10011010 

ファイルレジスタ 

10011010 MEM1 



; Data from Working Register to File Register and vice versa 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF 
 
MEM1 EQU 0x0C  
MEM2 EQU 0x0C+1 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 MOVLW    0x9A   
  
 MOVWF MEM1   
  
 MOVLW 0x01   
 
 MOVWF MEM2   
 
 MOVF MEM1,0   
 
 MOVF MEM2,0   
 
 
 GOTO START 
  
 END 23 

wレジスタに
00000001という

数を転送せよと
いう命令 

Wレジスタ 

00000001 

ファイルレジスタ 

10011010 MEM1 



; Data from Working Register to File Register and vice versa 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __ CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF 
 
MEM1 EQU 0x0C  
MEM2 EQU 0x0C+1 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 MOVLW    0x9A   
  
 MOVWF MEM1   
  
 MOVLW 0x01   
 
 MOVWF MEM2   
 
 MOVF MEM1,0   
 
 MOVF MEM2,0   
 
 
 GOTO START 
  
 END 24 

Wレジスタ 

wレジスタの内容

をファイルレジスタ
のMEM2に転送
せよという命令 

00000001 

ファイルレジスタ 

10011010 
00000001 

MEM1 
MEM2 



; Data from Working Register to File Register and vice versa 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF 
 
MEM1 EQU 0x0C  
MEM2 EQU 0x0C+1 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 MOVLW    0x9A   
  
 MOVWF MEM1   
  
 MOVLW 0x01   
 
 MOVWF MEM2   
 
 MOVF MEM1,0   
 
 MOVF MEM2,0   
 
 
 GOTO START 
  
 END 25 

Wレジスタ 

MEM1の内容をw
レジスタに転送せ
よという命令 

10011010 

ファイルレジスタ 

10011010 
00000001 

MEM1 
MEM2 

MOVF f, d    
レジスタfの中身をdへ転送せよと言う命令 
d = 0はWレジスタ 



; Data from Working Register to File Register and vice versa 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF 
 
MEM1 EQU 0x0C  
MEM2 EQU 0x0C+1 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 MOVLW    0x9A   
  
 MOVWF MEM1   
  
 MOVLW 0x01   
 
 MOVWF MEM2   
 
 MOVF MEM1,0   
 
 MOVF MEM2,0   
 
 
 GOTO START 
  
 END 26 

Wレジスタ 

MEM2の内容をw
レジスタに転送せ
よという命令 

00000001 

ファイルレジスタ 

10011010 
00000001 

MEM1 
MEM2 



; Data from Working Register to File Register and vice versa 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF 
 
MEM1 EQU 0x0C  
MEM2 EQU 0x0C+1 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 MOVLW    0x9A   
  
 MOVWF MEM1   
  
 MOVLW 0x01   
 
 MOVWF MEM2   
 
 MOVF MEM1,0   
 
 MOVF MEM2,0   
 
 
 GOTO START 
  
 END 27 

Wレジスタ 

00000001 

ファイルレジスタ 

10011010 
00000001 

MEM1 
MEM2 

STARTへジャ
ンプする． 
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演習問題１．MEM1に0xAA，MEM2に 
      0xBBを転送し，これらを 
      交換するプログラムを作成 
      せよ． 
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演習問題１．MEM1に0xAA，MEM2に0xBBを転送し，これらを交換するプログラ
ムを作成せよ． 
 
; Problem 1 
 
 INCLUDE"p16F84A.inc" 
 list p=16F84A 
 
 __CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF 

 
MEM1 EQU 0x0C  ;MEM1 at 0C 
MEM2 EQU 0x0C+1  ;MEM2 at 0D 
MEM3 EQU 0x0C+2  ;MEM3 at 0E 
 
 ORG 0 
 GOTO START 
 ORG 4 
 
START 
 
 MOVLW    0xAA  ; ‘AA' to Working Register 
 MOVWF MEM1  ; Move ‘AA' to MEM1 
 MOVLW 0xBB  ; ‘BB' to Working Register 
 MOVWF MEM2  ; Move ‘BB'  to MEM2 
 
 MOVF MEM1, 0  ;Load MEM1 to W 
 MOVWF MEM3  ;Move W to MEM3 
 MOVF MEM2,0  ;Load MEM2 to W 
 MOVWF MEM1  ;Move W to MEM1 
 MOVF  MEM3,0  ;Load MEM3 to W 
 MOVWF MEM2  ;Move W to MEM2 
 
 GOTO START 
 END 

MEM1に0xAA，
MEM2に0xBBを転送 

MEM1の内容を一端
MEM3に転送し，MEM2
の内容をMEM1に移した
後に，MEM3の内容を
MEM2に転送 
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*

２．転送命令を学ぼう

2004年8月に本講義ノートをWebにアップして以来，とても多くの方の訪問を受けてきました．内容が一部古くなっていたので，2012年5月時点の情報に書き改めました．主な変更点は以下の通りです．



第0章に本講座の準備のための章を設け，以下の更新をしました．



１．プログラム開発環境(MPLAB IDE)をv8.84に更新しました．

        2012年5月時点での最新バージョンはMPLAB X IDE v1.10ですが，アセンブラの勉強のためには，旧バージョンのv8.84が良さそうです．（筆者がXを使いこなしていないこともあります．）

２．ブレッドボード上に回路を製作し，その詳細を記しました．

　　ハンダ付けをほとんど必要とせずにマイコン回路を製作できます．

３．部品を全てネットで購入して，その仕様と入手先を記しました．

　　入手が容易な部品ばかりでマイコン回路を製作しました．

４．In-Circuit Debugger/ProgrammerにPICkit3を用いました．

　　ブレッドボード上のマイコンへのプログラミングにPICkit3を使用した例を記しました．





*









*

　

; Load of Literal to Working Register



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &    _CP_OFF



	ORG	0

	GOTO	START

	ORG	4



START



	MOVLW   	B'10011010'	; Binary number



	MOVLW		0xAB		; Hexadecimal number



	MOVLW		D'255'		; Decimal number



	GOTO		START

	

	END

まず，このソースファイルを打ち込んで下さい．

MPLAB IDE v8.84の立ち上げ方，Project Fileの作り方，アセンブラのソースファイルの作り方，ビルドの仕方，シミュレーションの仕方は第0章を参照してください．　注意 CONFIGの前のアンダーバーは2つあります．

これはWレジスタにLiterarl（リテラル，文字）を転送させるプログラムです．最初に2進数の10011010を転送し，次に16進数のABを転送し，最後に10進数の255を転送します．

MOVLWはMove Literal to Working registerの略です．





*









*

カーソルをここに持ってきて右クリック

シミュレーションの仕方

プログラムを打ち込み終わったら，Debugger → Select Tool → MPLAB SIM → Project → Makeと選択すると，プログラムに文法上の間違いがなければ，BUILD SUCCEEDEDというメッセージが出ます．次にView → Special Function Registersを選択して下さい．下図のようにレジスタ群の内容を示すウィンドウが開かれます．図示の位置にカーソルを持ってきて右クリックすると，レジスタ内容の表示型をHex(16進数)，Binary(2進数)，Decimal(10進数)，Char（文字型）の中から選択できます．







*

DecimalとBinaryを表示

ファンクションキーのF7を押して，プログラムを一行ずつ実行して，　 WREG (Wレジスタ）の中の数字がどう書き換えられていくかを確認してください．

Wレジスタ内の数字が表示されています．







*



命令デコーダ

コントローラ

８レベルスタック

ファイルレジスタ

８ビット

FSRレジスタ

入出力ポート



プログラムメモリ

命令レジスタ

MUX

STATUSレジスタ

Wレジスタ













１４

1３ビット

１３

７

６８



７

間接

アドレス

RA４～RA０

RB７～RB０

制御信号

…

ＭＵＸ











５

直接アドレス

８



ＡＬＵ































８

８

データバス



プログラムカウンタ

打ち込んだプログラムはプログラムメモリに格納されます．マイコンの電源を入れると，プログラムメモリから命令が順次読み出され，実行されていきます．

PIC16F84AのData SheetのBLOCK DIAGRAMの抜粋です．





*









*



命令デコーダ

コントローラ

８レベルスタック

ファイルレジスタ

８ビット

FSRレジスタ

入出力ポート



プログラムメモリ

命令レジスタ

MUX

STATUSレジスタ

Wレジスタ













１４

1３ビット

１３

７

６８



７

間接

アドレス

RA４～RA０

RB７～RB０

制御信号

…

ＭＵＸ











５

直接アドレス

８



ＡＬＵ































８

８

データバス



プログラムカウンタ

マイコンの中にはWレジスタ(Working Register)という8ビットの数字を記憶しておく場所があります．様々な処理のための「作業用レジスタ」という意味です．

PIC16F84AのData SheetのBLOCK DIAGRAMの抜粋です．





*









*



命令デコーダ

コントローラ

８レベルスタック

ファイルレジスタ

８ビット

FSRレジスタ

入出力ポート



プログラムメモリ

命令レジスタ

MUX

STATUSレジスタ

Wレジスタ













１４

1３ビット

１３

７

６８



７

間接

アドレス

RA４～RA０

RB７～RB０

制御信号

…

ＭＵＸ











５

直接アドレス

８



ＡＬＵ































８

８

データバス



プログラムカウンタ

MOVLW   　B‘10011010’　の実行

プログラムがスタートすると最初にMOVLWがプログラムメモリから命令デコーダに読み込まれ，ここで命令の解読，コントローラにより実行されます．MOVLWの次の10011010がWレジスタに転送されます．





*









*

; Load of Literal to Working Register



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &    _CP_OFF



	ORG	0

	GOTO	START

	ORG	4



START



	MOVLW   	B'10011010'



	MOVLW		0xAB



	MOVLW		D'255'



	GOTO		START

	

	END



Configuration設定です．マイコンのシステムクロックを設定します．



MicrochipのWebページからダウンロードできるPIC16F84AのData Sheetの21ページにConfigurationの説明があります．

OSC: Oscillator

   RC: Resistor/Capacitor

　　   内蔵の発振回路，4MHz程度まで

          発信周波数は不安定

   HS: High Speed Crystal/Resonator

           3.5MHz 以上で推奨

 本回路では10MHzのセラミック発振子を外付けしてあるので，HS設定とする．

   XT: Crystal/Resonator

　       4 MHz 以下

   LP: Low Power Crystal

　　   低消費電力, 200kHz 以下



WDT: Watch Dog Timer



PWRTE: Power up Timer Enable



CP: Code Protection



本資料の使い方の範囲内では全てオフで差し支えない．







*

; Load of Literal to Working Register



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &    _CP_OFF



	ORG	0

	GOTO	START

	ORG	4



START



	MOVLW   	B'10011010'



	MOVLW		0xAB



	MOVLW		D'255'



	GOTO		START

	

	END



現実のマイコンでは電源を入れるとここから始まります．



STARTへジャンプする．







*

; Load of Literal to Working Register



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &    _CP_OFF



	ORG	0

	GOTO	START

	ORG	4



START



	MOVLW   	B'10011010'



	MOVLW		0xAB



	MOVLW		D'255'



	GOTO		START

	

	END







Wレジスタ



10011010



wレジスタに100110101という数を転送せよという命令です．

B’10011010’    2進数は

= D‘154’ 　　　10進数

= H‘9A’          16進数です．

表現が違うだけでどれも同じ数字です．







; Load of Literal to Working Register



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &    _CP_OFF



	ORG	0

	GOTO	START

	ORG	4



START



	MOVLW   	B'10011010'



	MOVLW		0xAB



	MOVLW		D'255'



	GOTO		START

	

	END

*







Wレジスタ



10101011



wレジスタにABという数を転送せよという命令です．

B’10101011’    2進表現

= D‘171’ 　　　10進表現

= H‘AB’          16進表現







; Load of Literal to Working Register



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &    _CP_OFF



	ORG	0

	GOTO	START

	ORG	4



START



	MOVLW   	B'10011010'



	MOVLW		0xAB



	MOVLW		D'255'



	GOTO		START

	

	END

*







Wレジスタ



11111111



wレジスタに255という数を転送せよという命令です．

B’11111111’    2進表現

= D‘255’ 　　　10進表現

= H‘FF’          16進表現







*







Wレジスタ

11111111

STARTへジャンプする．

; Load of Literal to Working Register



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &    _CP_OFF



	ORG	0

	GOTO	START

	ORG	4



START



	MOVLW   	B'10011010'



	MOVLW		0xAB



	MOVLW		D'255'



	GOTO		START

	

	END







*

次に，ワーキング（W）レジスタとファイルレジスタ間でのデータのやりとりを体験してください．







*



命令デコーダ

コントローラ

プログラムカウンタ

(PC)

８レベルスタック

ファイルレジスタ

８ビット

FSRレジスタ

入出力ポート



プログラムメモリ

（フラッシュメモリ）

命令レジスタ

MUX

STATUSレジスタ

Wレジスタ













1４ビット

１０２４

１４

1３ビット

１３

７

６８



７

間接

アドレス

RA４～RA０

RB７～RB０

制御信号

…

ＭＵＸ











５

直接アドレス

８



ＡＬＵ































８

８

データバス

　　ＰＩＣ１６Ｆ８４Aの構成

マイコンの中にはファイルレジスタ(File Register)という8ビットの数字を記憶できるレジスタが68個あります．







*

0x0C

0x4F

0C～4Fの番地を持つ68個の８ビットレジスタがある．



8ビットの数字を68個までしまっておける「引き出し」のようなもの．



データの「一時保管所」のような意味です．

　　　ファイルレジスタ　　　　









　　　wレジスタ　　　　

Wレジスタはたった１個の８ビットレジスタからなる．







*

; Data from Working Register to File Register and vice versa



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF



MEM1	EQU	0x0C		;MEM1 at 0C

MEM2	EQU	0x0C+1		;MEM2 at 0D



	ORG	0

	GOTO	START

	ORG	4



START

	MOVLW   	0x9A		; '9A' to Working Register

	

	MOVWF	MEM1		; Move '9A'  to MEM1

	

	MOVLW	0x01		; '01' to Working Register



	MOVWF	MEM2		; Move '01'  to MEM2



	MOVF	MEM1,0		; Load '9A' from MEM1 to W



	MOVF	MEM2,0		; Load '01' from MEM2 to W





	GOTO	START

	

	END

このプログラムを打ち込んで下さい．





シミュレータでプログラムをステップ実行しながら，w, MEM1, MEM2レジスタの中の数字がどう変わるか確認して下さい．









*

MEM1, MEM2の中の数字は，View → File Registersにより見ることができます．

0C番地にMEM1

0D番地にMEM2







*

0C番地のファイルレジスタにMEM1という名前を

つけ，0C+1 ( = 0D)番地のファイルレジスタにMEM2という名前を付けます．



; Data from Working Register to File Register and vice versa



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF



MEM1	EQU	0x0C		;MEM1 at 0C

MEM2	EQU	0x0C+1		;MEM2 at 0D



	ORG	0

	GOTO	START

	ORG	4



START

	MOVLW   	0x9A		; '9A' to Working Register

	

	MOVWF	MEM1		; Move '9A'  to MEM1

	

	MOVLW	0x01		; '01' to Working Register



	MOVWF	MEM2		; Move '01'  to MEM2



	MOVF	MEM1,0		; Load '9A' from MEM1 to W



	MOVF	MEM2,0		; Load '01' from MEM2 to W





	GOTO	START

	

	END







*



電源を入れるとORG 0の次から始まります．

STARTへジャンプする．

; Data from Working Register to File Register and vice versa



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF



MEM1	EQU	0x0C		;MEM1 at 0C

MEM2	EQU	0x0C+1		;MEM2 at 0D



	ORG	0

	GOTO	START

	ORG	4



START

	MOVLW   	0x9A		; '9A' to Working Register

	

	MOVWF	MEM1		; Move '9A'  to MEM1

	

	MOVLW	0x01		; '01' to Working Register



	MOVWF	MEM2		; Move '01'  to MEM2



	MOVF	MEM1,0		; Load '9A' from MEM1 to W



	MOVF	MEM2,0		; Load '01' from MEM2 to W





	GOTO	START

	

	END







*





Wレジスタ



10011010

; Data from Working Register to File Register and vice versa



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF



MEM1	EQU	0x0C	

MEM2	EQU	0x0C+1



	ORG	0

	GOTO	START

	ORG	4



START

	MOVLW   	0x9A		

	

	MOVWF	MEM1		

	

	MOVLW	0x01		



	MOVWF	MEM2		



	MOVF	MEM1,0		



	MOVF	MEM2,0		





	GOTO	START

	

	END

wレジスタに100110101という数を転送せよという命令







; Data from Working Register to File Register and vice versa



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF



MEM1	EQU	0x0C	

MEM2	EQU	0x0C+1



	ORG	0

	GOTO	START

	ORG	4



START

	MOVLW   	0x9A		

	

	MOVWF	MEM1		

	

	MOVLW	0x01		



	MOVWF	MEM2		



	MOVF	MEM1,0		



	MOVF	MEM2,0		





	GOTO	START

	

	END



*





Wレジスタ



wレジスタの内容をファイルレジスタのMEM1に転送せよという命令です．

MOVE W to F の略です．

10011010



ファイルレジスタ

10011010

MEM1







; Data from Working Register to File Register and vice versa



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF



MEM1	EQU	0x0C	

MEM2	EQU	0x0C+1



	ORG	0

	GOTO	START

	ORG	4



START

	MOVLW   	0x9A		

	

	MOVWF	MEM1		

	

	MOVLW	0x01		



	MOVWF	MEM2		



	MOVF	MEM1,0		



	MOVF	MEM2,0		





	GOTO	START

	

	END



*





wレジスタに00000001という数を転送せよという命令



Wレジスタ

00000001



ファイルレジスタ

10011010

MEM1







; Data from Working Register to File Register and vice versa



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__ CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF



MEM1	EQU	0x0C	

MEM2	EQU	0x0C+1



	ORG	0

	GOTO	START

	ORG	4



START

	MOVLW   	0x9A		

	

	MOVWF	MEM1		

	

	MOVLW	0x01		



	MOVWF	MEM2		



	MOVF	MEM1,0		



	MOVF	MEM2,0		





	GOTO	START

	

	END



*





Wレジスタ



wレジスタの内容をファイルレジスタのMEM2に転送せよという命令

00000001



ファイルレジスタ

10011010

00000001

MEM1

MEM2







; Data from Working Register to File Register and vice versa



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF



MEM1	EQU	0x0C	

MEM2	EQU	0x0C+1



	ORG	0

	GOTO	START

	ORG	4



START

	MOVLW   	0x9A		

	

	MOVWF	MEM1		

	

	MOVLW	0x01		



	MOVWF	MEM2		



	MOVF	MEM1,0		



	MOVF	MEM2,0		





	GOTO	START

	

	END



*





Wレジスタ



MEM1の内容をwレジスタに転送せよという命令

10011010



ファイルレジスタ

10011010

00000001

MEM1

MEM2

MOVF	f, d   

レジスタfの中身をdへ転送せよと言う命令

d = 0はWレジスタ







; Data from Working Register to File Register and vice versa



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF



MEM1	EQU	0x0C	

MEM2	EQU	0x0C+1



	ORG	0

	GOTO	START

	ORG	4



START

	MOVLW   	0x9A		

	

	MOVWF	MEM1		

	

	MOVLW	0x01		



	MOVWF	MEM2		



	MOVF	MEM1,0		



	MOVF	MEM2,0		





	GOTO	START

	

	END



*





Wレジスタ



MEM2の内容をwレジスタに転送せよという命令

00000001



ファイルレジスタ

10011010

00000001

MEM1

MEM2







; Data from Working Register to File Register and vice versa



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF



MEM1	EQU	0x0C	

MEM2	EQU	0x0C+1



	ORG	0

	GOTO	START

	ORG	4



START

	MOVLW   	0x9A		

	

	MOVWF	MEM1		

	

	MOVLW	0x01		



	MOVWF	MEM2		



	MOVF	MEM1,0		



	MOVF	MEM2,0		





	GOTO	START

	

	END



*



Wレジスタ

00000001



ファイルレジスタ

10011010

00000001

MEM1

MEM2



STARTへジャンプする．







*

演習問題１．MEM1に0xAA，MEM2に

　　　　　　0xBBを転送し，これらを

　　　　　　交換するプログラムを作成

　　　　　　せよ．







*

演習問題１．MEM1に0xAA，MEM2に0xBBを転送し，これらを交換するプログラムを作成せよ．



; Problem 1



	INCLUDE"p16F84A.inc"

	list p=16F84A



	__CONFIG   _HS_OSC  &   _WDT_OFF  &   _PWRTE_OFF  &   _CP_OFF



MEM1	EQU	0x0C		;MEM1 at 0C

MEM2	EQU	0x0C+1		;MEM2 at 0D

MEM3	EQU	0x0C+2		;MEM3 at 0E



	ORG	0

	GOTO	START

	ORG	4



START



	MOVLW   	0xAA		; ‘AA' to Working Register

	MOVWF	MEM1		; Move ‘AA' to MEM1

	MOVLW	0xBB		; ‘BB' to Working Register

	MOVWF	MEM2		; Move ‘BB'  to MEM2



	MOVF	MEM1, 0		;Load MEM1 to W

	MOVWF	MEM3		;Move W to MEM3

	MOVF	MEM2,0		;Load MEM2 to W

	MOVWF	MEM1		;Move W to MEM1

	MOVF 	MEM3,0		;Load MEM3 to W

	MOVWF	MEM2		;Move W to MEM2



	GOTO	START

	END



MEM1に0xAA，MEM2に0xBBを転送



MEM1の内容を一端MEM3に転送し，MEM2の内容をMEM1に移した後に，MEM3の内容をMEM2に転送







*

2004年8月







